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Introduction

Ce  tutoriel  se  veut  une  simple  introduction  au  logiciel  LTSPICE.  Le  logiciel  fourni 

gratuitement par  Linear Technologie ne comporte aucune limitation d'utilisation et  permet 

d'utiliser toutes les fonctionnalités de SPICE .

Visite  guidée.

Présentation de LTspice

Ltspice est donc un logiciel gratuit 

que l'on peut télécharger depuis le 

site de Linear Technologie1.

L'installation est  des plus simple. 

Il  suffit  de  double  cliquer  sur 

l'archive  auto-extractible  et  de 

répondre aux questions. Une icône 

SWCAD  III est  placée  sur  votre 

bureau.  Lancez le programme et 

la fenêtre ci-dessous apparaît. 

Cette fenêtre principale  donne accès 

à toutes les fonctionnalités de Ltspice.  Comme dans la plupart  des logiciels  modernes les 

ressources  sont  accessibles  de  différentes  façons  à  travers  des  menus,  des  icônes  et  des 

touches de raccourci clavier. Nous ne présenterons pas les différents moyens de réaliser une 

tâche.  Nous  nous  contenterons  de  présenter  la  plus  pratique,  c'est  à  dire  celle  que  nous 

connaissons.

1 - http://www.linear.com
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Contenu du tutoriel

Dans ce tutoriel vous découvrirez comment réaliser un schéma très simple. Pourquoi 

pas  un filtre  passe bas  ?  Nous  évoluerons  vers  le  filtre  passe  haut  pour  terminer  par  un 

magnifique passe bande.  Nous verrons également, chemin faisant, l'utilisation d'un modèle 

SPICE 1.

Ces exemples très simples seront matière à utiliser les différentes fonctionnalités de Ltspice. 

Nous passerons en revu   l'édition de schéma, la sauvegarde de nos travaux . Nous utiliserons 

les symboles hiérarchisés,  intégrerons des modèles Spice et  serons en mesure de passer des 

paramètres à ces modèles. Nous verrons également comment visualiser les résultats et définir 

des fonctions 

 Enfin bref,  à  la fin de ce tutoriel vous  devriez.., vous serez,  en mesure de réaliser 
vos propres simulations.

Mon premier schéma. 

Ouvrir une feuille

Cliquez sur cette icône dans Ltspice. Une nouvelle fenêtre d'édition apparaît.

Vous pouvez remarquer qu'un grand nombre d'icônes sont devenues actives.

Placer des composants

Nous allons maintenant rentrer notre premier schéma.
Une  résistance,  une  capacité.   Vous  allez  cliquer  sur  l'icône 
correspondante dans  la  barre  d'outils  pour  réaliser  le schéma ci 
contre.  Un clic sur le crayon et vous tracez vos fils de connexions. 

A savoir  :  Un clic  gauche  sur 
l'icône fait apparaître le fantôme du 
composant  que  vous  validez  sur  votre  fenêtre  d'édition  par  un 

nouveau clic gauche. Continuez à cliquez gauche autant de fois que de composants désirés. 

1 SPICE : Simulation Program with Integrated Circuit Emphasis
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Pour  terminer  l'opération  clic  droit.  Ce  mode  opératoire  est 
valable pour tracer les fils.Nommer des connexions
Pour  fonctionner  le  simulateur  doit  impérativement  utiliser  un 
symbole  de  masse.   Les  autres  fils  sont  automatiquement 
numérotés Nxxx mais il  est préférable de nommer certains fils 
pour des commodités de visualisations. Utilisez l'icône     de la 
barre d'outils. Une nouvelle fenêtre apparaît  Dans le champ ABCABC  
vous pouvez entrer un nom pour votre connexion et choisir un 
type1. Les types GND et COM sont prédéfinis.  Si vous commencez un nom par $G_{string} 
alors le nom est global à toute votre  hiérarchie schématique.

Modifier les propriétés

 Placez vous au dessus de l'objet que vous souhaitez modifier et 
cliquez droit. Une boite de dialogue apparaît vous permettant 
de configurer votre schéma. Ci-contre nous pouvons configurer 
la résistance. Un bouton2  permet de choisir parmi une liste  de 
résistances mais vous pouvez entrer directement une valeur.

Quelques fonctionnalités d'édition

• Supprimer un élément :   touche clavier  Suppr, un ciseau apparaît à 
l'écran. Un clic sur l'objet et il est effacé.

• Supprimer un ensemble  : entourer l'ensemble avec le ciseau
• Annuler une opération:   touche clavier F9
• Déplacer des objets   : les petites mains. Cliquez sur  l'objet ou entourez 

l'ensemble.

Placer et configurer une source 

Pour pouvoir  simuler un circuit  vous 
devez  ajouter  au  moins  une  source. 
Pour ajouter un générateur on procède 
comme pour un composant  classique. 
On ouvre le sélecteur de composant en 
cliquant sur l'icône .

 On  ajoute  une  source  nommée 
Voltage  Placez la source et raccordez 
la au montage. Éditez les propriétés de 
la  source  en  cliquant  droit  sur  le 
symbole  puis sur 'advanced'3

1 Entrée, sortie, bidirectionnelle. 
2 Select Resistor
3Avancées dans la langue de Molière.
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Il est important de remarquer que la 
source  que  nous  avons  choisi  peut 
être  utilisée  pour  différentes 
simulations  en  fonction  des 
paramètres qu'on lui donne. Pour la 
simulation  AC  que  nous  allons 
réaliser  sur  ce  montage,  il  faudra 
renseigner  les  paramètres  « small 
signal AC analysis 1» 

Ac amplitude =1v      Ac phase =0
Enregistrer le schéma
Pensez à sauvegardez votre fichier quelque part sur votre espace de stockage.  Pensez à classer 
vous  fichiers  pour  une  meilleure  organisation.  Ex:  Créez  une  arborescence   :  Filtre et 
sauvegardez dans ce répertoire  filtre votre schéma sous le nom  filtre_pbas2

Généralités sur les sources.

s trouverez la 
Le  tableau  ci  contre  vous  donne  les  éléments 
connus de Spice.  Dans la liste des sources il est à 
noter les éléments   de Type B ( Bi et  Bv) qui 
permettent de définir des signaux complexes.
  Ces  sources  remplacent  avantageusement  les 
source E, F, G et H.

1Ce qui traduit donne : Analyse petit signal.
2Respectez les noms des  répertoires et des  fichiers pour pouvoir suivre plus aisément le tutoriel.
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Premières simulations

Aperçu des différentes analyses.

Lorsque  vous  lancez  une  simulation.  La  fenêtre  de   de  configuration  d'analyses  s'ouvre. 
(l'illustration 2 ).
Différents onglets correspondent à différents types d'analyses.

Analyse DC OP (DC - Operating Point)
Cette analyse définie le point de polarisation du montage en continu. Une fenêtre s'ouvre et 
donne les courants et tensions en chaque nœud du circuit. La variation de la valeur d'un 
élément permet de tracer des courbes en fonction de cette valeur1. Les capacités sont vues 
comme des circuits ouverts et les inductances comme des courts-circuits. C'est une  analyse 
statique

Analyse DC transfer. 
C'est  une  analyse  petit  signal  autour  du  point  de 
polarisation.  Cette  analyse  donne  les  impédances 
d'entrée et  de sortie de votre montage ainsi  que  la 
fonction de transfert petit signal. Le circuit est donc 
linéaire autour du point de polarisation.  (Une faible  
variation  de  la  source  autour  du  point  de  
polarisation)

Analyse DC sweep
Réalise une simulation DCOP pour chaque valeur de 
source  .  La source  varie   suivant  un  pas  que  vous 
aurez déterminé. C'est une  analyse statique

Analyse transient
Analyse non linéaire temporelle, on trace les signaux en fonction du temps. Analyse AC
Analyse  fréquentielle petit  signal   après 
linéarisation du circuit autour de sont point 
de polarisation. Il est nécessaire de définir la 
valeur  petit  signal  de  la  source  en  faisant 
apparaître la fenêtre de configuration de la 
source  par  un  clic  droit  de  la  souris  sur 
celle-ci.

1 Add trace dans la fenêtre graphique qui apparaît et sélectionner les nœuds à visualiser.

Retour P3 Page 10 / 30
Carlos.Valente@brive.unilim.fr GE&II 19100 BRIVE - France.

mailto:Carlos.Valente@brive.unilim.fr


LTspice Version document du 07/04/2009

© Geii. Brive 2006

Analyse AC

Un  clic  sur  l'icône  run1 et  la  fenêtre  de 
configuration  de   simulation   apparaît.  Les 
onglets  représentent  les  différents  types  de 
simulations que vous pouvez réaliser. 

Pour notre première analyse nous allons choisir 
AC.  C'est  à  dire  faire  varier  la  source 
sinusoïdale  entre  deux  valeurs  de  fréquences. 
Nous obtiendrons ainsi la fonction de transfert 
du filtre passe-bas.  Renseignez les champs 

comme dans l'illustration 2 et validez.

Remarquez  en  passant que  les  informations  
d'analyses sont entrées comme une directive Spice 
directement sur le schéma. Un clic droit sur cette  
ligne et vous pouvez modifier vos paramètres.

Une fenêtre de visualisation des courbes vous demande 
de  choisir  les  signaux  que  vous  souhaitez  visualiser. 
Choisissez V(out). Vous pourrez par la suite choisir de 
visualiser n'importe quel point du montage. 

Visualisation d'un autre 
point du montage

Pour  visualiser  un  autre  point  du 
montage   il  suffit  de  déplacer  le 
curseur sur un fil  pour visualiser un 
potentiel  et un composant pour avoir 
une image du courant2

1Petit bonhomme qui court
2Le curseur change d'aspect. Sonde pour une tension et pince ampère métrique pour un courant.
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Utilisation de l'existant

Les symboles

Avant  de  nous 
lancer  dans  la 
création de symboles il est 
nécessaire de signaler que 
de  nombreuses 
représentations   existent 
dans  Lstpice   ainsi  qu'un 
grand nombre d'exemples.
 Évidemment  les 
composants  sont  ceux  de 
Linear  technologie  mais 
nous verrons qu'il  est très 
facile  de  s'approprier  ces 
symboles  et  de  les 

configurer  pour  notre  propre  compte.  De  plus,  un  grand 
nombre de contributions existent sur Internet. En particulier 
un groupe de travail sur Yahoo (Voir Annexe)

Les exemples

De nombreux exemples sont présents dans le 
répertoire :
"C:\Program Files\LTC\SwCADIII\examples"

Certains de ces exemples sont  automatiques  
et ne nécessitent aucune configuration.

Ouvrez: File > Demo SMPS Circuits

Configuration symboles

Certains  symboles  sont  paramétrés.  Un  bouton  de  leur 
fenêtre de propriétés permet de choisir parmi une liste de 
composants.
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Création d'un Symbole

Il est fort probable qu'un jour vous souhaitiez simuler un circuit qui ne se trouve pas dans les 
bibliothèques. Comment faire alors ? 
Vous  devrez créer un symbole et lui associer une description comportementale. 

Le symbole

Créer  un symbole  est  chose facile  sous  ltspice.  Nous allons  réaliser  un  symbole  complet 
sachant qu'il est possible d'ouvrir un symbole existant de le modifier et de le sauvegarder sous 
un autre nom.

Créer des bibliothèques.

Vous pouvez installer tous vos nouveaux symboles dans les bibliothèques existantes mais il 
serait souhaitable de  les placer dans des  répertoires personnalisés. Nous allons donc créer 
trois répertoires. Ma_lib1 dans :

"C:\Program Files\LTC\SwCADIII\lib\sym\Ma_lib" 
"C:\Program Files\LTC\SwCADIII\lib\sub\Ma_lib" 
"C:\Program Files\LTC\SwCADIII\lib\sch\Ma_lib"

vous pouvez bien entendu en créer autant que vous le désirez. 

Pour notre exemple nous allons créer une boîte avec 
une entrée et une sortie qui représentera notre filtre 
RC  du  début.  Ouvrez  une  fenêtre  d'édition  de 
symboles2.

En utilisant  les outils  du menu Draw dessinez un 
symbole  représentant  votre  filtre  (Voir 
Illustration4.)

Faites Edit> Attributes>Edit  Attributs.  Si  on laisse vide les champs on définit  le symbole 
comme un composant hiérarchique dont  le modèle de comportement est un  schéma.

1Attention ! Les bibliothèques ne seront visibles que lors du futur lancement de ltpsice.
2 Menu : File >New symbol
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Ajout d'entrées/sorties aux symboles.

Utilisez  la touche [P]1 du clavier Une fenêtre apparaît. Renseignez la puis validez. Placez le 
fantôme à l'endroit désiré. Un clic droit sur la broche pour modifier les attributs. Nommez 
l'entrée IN et la sortie OUT. 

Enregistrer le symbole.

File > Save As  et choisissez la bibliothèque Ma_lib  et appelez le Bloc_pbas2

"C:\Program Files\LTC\SwCADIII\lib\sym\Ma_lib"

Utiliser le nouveau symbole

Créez un nouveau schéma. Appelez le Fitre_pbas_h3  et placez sur la feuille votre symbole 
Bloc_pbas. Placez également un générateur de tension (voir illustration1. Vous devez obtenir 
un schéma ressemblant à celui-ci.

Enregistrez votre schéma dans un répertoire nommé simul_hierarchique
Lancez la simulation et configurez (voir Illustration2)  
le simulateur vous signale que vous n'avez pas entré de modèle ou schéma.

1.Menu Edit > Add Pin/port
2Bloc Passe Bas
3Filtre passe bas hiérarchique 
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Les symboles hiérarchisés 

Un symbole,  en  lui  même  n'est  qu'une simple  représentation  graphique.  Pour  qu'il  ait  un 
comportement vous devez lui associer, soit un fichier Spice, soit un autre schéma qui sera 
composé d'éléments connus de Spice.  Ce modèle comportemental, dans le cas d'un schéma, 
devra être enregistré dans le même répertoire que votre projet à simuler.

Nous allons donc attribuer à notre symbole le  fichier Filtre_pbas que nous avons réalisé plus 
haut. Enregistrement dans le même  répertoire  « simul_hierarchique »  avec le même nom 
que le symbole auquel il sera associé.1

Attention  le  symbole et  le  fichier  de description  doivent  porter le  même nom. Et se 
trouver dans le même répertoire !

Passer des 
paramètres à vos 
sous-schémas.

Un  symbole  peut  être  utilisé 
plusieurs  fois  dans  votre 
application  avec  un 
comportement  différent.  Par 
exemple deux filtres passe bas 
ayant  une  fréquence  de 
coupure différente.

Il faut  donc passer le  couple R et  C au 
sous-schéma. Cette opération est réalisée 
en mettant dans la valeur de R et C  un 
paramètre noté {res} pour R et {cap} C.
Dans les propriétés du symbole ajouter la 
valeur  des  variables  dans  le  champ 
Spiceline2

Il  est  possible  d'utiliser  des  fonctions 
pour  calculer  la  valeur  des  éléments.  
(Voir directives )

1 bloc_pbas.asc
2Par exemple : Res=10k cap=100n
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En  passant  des  paramètres 
différents  aux  symboles  nous 
pouvons  visualisez  deux 
comportements   pour  une 
même représentation.
Cette  méthode  est  à  utiliser 
pour éviter de dessiner dans un 
schéma un sous  ensemble  qui 
se répète n fois. 

Visualisez les sorties.

On peut également donner les 
valeurs des éléments avec des 
formules
Par exemple en choisissant F0 , 
la  fréquence  de  coupure  des 
filtres. On sait:
 F0= 1/(2*π*Res*Cap )
 donc 
 Cap=1/(2*π*Res* F0)
en conséquence   la  valeur  de 
Cap est : { 1/(2*PI*Res* F0)}
Fixez la valeur de  F0   avec la 
directive : .param F0 = 2k

Si  on  décide  de  fixer  la 
fréquence il sera intéressant de connaître la valeur de la capacité. Pour faire afficher la valeur 
de la capacité  nous utiliserons la directive .Measure.
.MEAS  capacite  param  {1/
(2*pi*res*  F0)}  donne 
directement  la  valeur  de  la 
formule  dans  le  fichiers  error 
log. ( View >Spice error log. - 
Ce n'est pas une erreur!)
Exemple :
.MEAS capacité  param {cap} 
si  vous  avez  utilisé  la 
directive  .param  pour  définir 
cap
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Les modèles Spice.

Que sont les modèles Spice ?

Ce qu'il faut bien comprendre c'est que les symboles que vous placez sur la feuille d' édition 
ne sont que des représentations graphiques. Ces symboles ont pour fonction de représenter des 
composants  physiques  et  de permettre  une lecture aisée des  schémas.  Pour  qu'un logiciel 
puisse simuler leur fonctionnement  il  faut leur adjoindre un fichier de comportement.  Les 
composants  élémentaires  tels  les  résistances,   capacités,  bobines,  sources,...,  ont  des 
comportements  généralement  connus  des  simulateurs.  Ces  composants  élémentaires 
permettent de décrire des composants plus complexes. Ce peut être sous la forme schématique 
ou de fichiers texte appelés  fichiers Spice.  On peut dans Ltspice créer des fichiers spice de 
vos schémas.

Lorsque vous créez un symbole ou que vous souhaitez simuler un composant qui n'est pas 
connu de Ltspice il est bien évident que vous devez renseigner le logiciel sur l'endroit ou se 
trouvent les fichiers comportementaux. La description du chemin menant à vos bibliothèques 
sera réalisée  par la directive .lib [chemin/ fichier]1.  

convertir un schéma en fichier Spice utilisable par un 
symbole.

Avec la méthode des schémas nous  ne pouvons  utiliser  notre  symbole que pour  des filtres 
ayant la même topologie.

Une  autre  solution  consiste  à 
convertir  notre  schéma  en  fichier 
Spice  et  à  l'assigner  ensuite  au 
symbole.  Cela  est  très  facile  avec 
Ltspice. Vous dessinez  le schéma 
dans  Ltspice et  vous  visualisez  la 
Netlist au moyen du  menu View > 
Spice  Netlist.  Les  valeurs 
paramétrables  sont  entrées  entre 
crochets.

Netlist du fichier ci-contre

R1 IN Out {res}2

C1 Out P001 {cap}
L1 N001 Out {self}
L2 P001 0 10m
C2 IN N001 10n
.backanno
.end

Copiez  ces  lignes  dans  un  fichier 
spice_geii  dans  le   répertoire 

sub/geii de l'arborescence de Ltspice  (voir page-13 )

1 Attention vous devez  renseigner l'extension du fichier. (sous Windows pensez à faire afficher les extensions)
2     Les valeurs entre crochets sont comprises comme des paramètres.
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Ajouter  les  lignes  .subckt   .params 
et .ends.
Notre  modèle  porte  le  nom  de 
filtregeii2.   Il  faut  à  présent  dire  au 
simulateur d'utiliser ce modèle.

Utiliser un modèle Spice1.

Vous pouvez vous procurer les modèles 
Spice  des  composants  directement  sur 
le  site  web  des  Fabricants.  Pour  les 
utiliser,   procédez  comme  pour 
l'exemple page 8.
 Pour  cela  éditez  les  propriétés  du 
symbole filtre avec un clic droit.  Dans 
le champ préfixe entrez la lettre X2.

Dans le champ  spicemodel entrez le nom de votre sous circuit.  Ici filtregeii2 Puis dans le 
champ spiceline entrez les paramètres Res=10k cap=10n self=10m .Validez

.___________________________________________
A savoir.

Si vous avez créé un schéma hiérarchique en visualisant la netlist  du schéma comportemental 
de votre bloc vous avez directement la netlist  sans avoir besoin de modifier le fichier..

1  SPICE : Simulation Program with Integrated Circuit Emphasis
2 Permet de signaler à Ltspice l'utilisation du modèle et non d'un schéma.
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Illustration 8: Modèle Spice généré.
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Remarquez que les symboles sont à présent colorés. De plus dans notre exemple  la même 
représentation graphique sert à  présent  à simuler deux modèles différents.
 Pensez à ajouter la directive   .lib ou .include qui renseignent sur la bibliothèque utilisée.  

Astuce

On  peut  inclure  les  modèles 
directement sur la feuille d'édition. 
Cela permet  de faire des essais et 
évite de renseigner la directive .lib. 
Lorsque votre modèle fonctionne il 
est fortement conseillé de le placer 
dans un fichier. Vous évitez ainsi 
d'encombrer la feuille d'édition.
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Simulation des circuits logiques

Vous pouvez récupérer dans le groupe de travail de Yahoo les bibliothèques 74HC qui vous 
permettront de simuler des circuits logiques. Cette ressource comprend les modèles mais aussi 
les  représentations  schématiques.  Placez  les  bibliothèques  dans  l'arborescence  LTSPICE. 
N'oubliez pas de spécifier le nom de la bibliothèque sur votre schéma par la directive .lib ou 
.include.

Pour la visualisation des signaux vous devrez utiliser un composant  Dwiew sinon le système 
interprète les signaux comme analogiques et non numériques. Pensez à ajouter la directive .lib 
dview.lib

Création d'un Bus.

Il peut être intéressant pour une question de  simplification  schématique de définir un Bus.
La syntaxe du label Bus est :  Nom_bus[0-n] Pour se raccorder à un bus il faut utiliser un 
composant Tap ( Menu : Edit > Place Bus Tap ).  On peut utilise les Bus lors de la création 
d'un symbole hiérarchique. 
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Les directives Spice
Nous avons vu que l'on pouvait  placer des 
commandes  qui  donnent  au  simulateur  un 
certain  nombres  d'informations.  Les 
directives  .lib,  .include font  parti  de  ces 
commandes, elles renseignent le système sur 
l'emplacement de certains fichiers. D' autres 
directives  existent  nous  allons  nous 
intéresser à certaines  d'entre elles.
.param
Cette  directive  permet  de  définir  un  paramètre  que  vous  pourrez  utiliser  ensuite  dans  le 
schéma. La syntaxe est simple.

.param freq=10  Cette directive définit un paramètre freq et lui affecte la valeur 10. 
Vous pouvez utiliser  cette  variable  pour des symboles en l'entourant  des crochets.   {freq} 
Nous avons déjà vu cette syntaxe à la page 17.

On peut définir des tableaux synchronisé.  Explication :
On veut simuler un montage pour différents 
couple de  résistance et de capacité.
[(R1,C1);(R2,C2)........(Rn ,Cn)]  
On  commence  par  définir  le  nombre  de 
simulation 
.step param N list   1 2 3 4  4 simulation 
pour chaque valeur de N
Puis on définit  les tabeaux
.param resistance= table(N, 1,10k , 2,20k , 
3,40k , 4,100k)
.param  capacite= table(N,  1,10n , 2,15n , 
3,22n , 4,1u)
Le système va donc faire 4 simulations avec 
les 4 couples RC
.step
Cette directive permet de renouveler une simulation autant de fois que désirée. Elle comporte 
des variantes.

.step param Freq1 LIST 5k 10k 15K Cet exemple impose trois simulations à des 
fréquences différentes. On peut ajouter d'autres valeurs à la suite ( Voir: Exemple de directives
Params et Step) 

.step param Freq 5k 10k 2K Ici le paramètre list a disparu nous obtiendrons des 
simulations pour une fréquence comprise entre 5Khz et 10Khz par pas de 2Khz.

1 La casse n'est pas importante. Freq =freq.
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Utiliser la directive .meas.
La  directive  .meas   permet  d'effectuer  des 
opérations  sur  le  tableau  de  résultats  de  la 
simulation.  Les  résultats  se  retrouvent  dans  le 
fichiers spice errorlogs view> spice errorlogs 
Ex: .measure vmax max mag(V(out))  donne la valeur 
du maximum de la tension au nœud out. 
Il  est  possible  de  sauvegarder  ces  commandes 
dans un fichier que l'on pourra exécuter à volonté 
avec : File > execute .MEAS script1. 
 
La  directive  .Meas permet  d'afficher  la  bande 
passante  d'un  filtre  par  exemple  (Voir  
Documentation   Ltspice.:  résultat  dans  le  fichier  error.log)  ou le  temps  de  montée  d'un 
signal.
Utiliser la directive  .func
Cette directive permet de définir une fonction.  On peut ensuite utiliser cette fonction dans le 
calcul des éléments. Exemple: calcul de cap1 avec la fonction cap_cal(x,y)
.func cap_cal(x,y) { 1/(2*x*y*F0)}
.param cap1 = {cap_cal(pi,res)}

Ces fonctions peuvent être sauvegardées 
dans le fichier  Plot.defs  ( Plots settings 
>  Edit  Plot.defs  )  Puis  utilisees  pour 
tracer   des  courbes.  Dans  l'exemple  de 
gauche TD(v(out)) tracera dans la fenêtre 
graphique  le  retard   en  fonction  de  la 
fréquence .  (  Faire Add trace et  donner 
TD(v(out)).

Exemple d'utilisation des 
directives

Voici un exemple d'utilisation des directives 

Dans  l'exemple  Illustration  13 nous  avons 
configuré une source de tension sinusoïdale en 
renseignant  son  champ  fréquence  par  la 
variable  {freq}  Nous  insérons  ensuite  une 
directive  .params  pour  définir  la  variable  Freq et  la  directive  .step pour  demander  des 
simulations comprises entre 5Khz et 10kz par pas de 2Khz.

1 Penser à sélectionner la fenêtre de trace  le fichier n'est actif que sur cette fenêtre.
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Présentation des 
résultats
La présentation des résultats est 
très  performante dans Ltspice. 
Reportez vous à l'exemple du 
LM 311 Page Erreur : source de
la référence non trouvée 

Mesures & curseurs 
Visualisation des 
résultats.

Vous pouvez visualisez en direct 
toutes  les  valeurs  du  graphique 
en  déplaçant  simplement  votre 
souris  sur  les  courbes.  Relevez 
les valeurs en bas de l'écran.  Un 
clic sur le nom du signal affecte 
immédiatement un curseur à la courbe.
Vous pouvez  placer deux  curseurs en cliquant droit sur le nom de la courbe et en choisissant 
2  curseurs.  La  nouvelle  fenêtre  qui  apparaît  vous  donne  les 
différentes valeurs en X, Y, et différence (X,Y) vous obtenez 
également la pente (X2-X1)/(Y2-Y1). 
On peut également faire des mesures entre deux courbes ( ex : 
retard) en plaçant le curseur 1 sur un signal et le 2 sur l'autre.

Dans une simulation multiple on peut passer le curseur sur les 
différentes courbes en utilisant  les  flèches du clavier.  Un clic  
droit sur le curseur donne les informations des paramètres de l'analyse.

Mesure de puissance instantanée dans un composant.
Très facile. Appuyez la touche Alt et cliquez gauche avec la souris sur le composant désiré. 
( Attention pas en analyse AC !)

Tracer une tension différentielle
Il est possible de tracer des signaux en ayant une  autre référence que la masse. Cliquez en un 
point du circuit puis déplacez la sonde vers l'autre point en maintenant le bouton de la souris 
appuyé. On peut changer la référence cliquant droit sur un fil et choisissez « Mark référence » 
( Un curseur noir apparaît et reste actif jusqu'à une nouvelle simulation.

Tracer une expression mathématique
Menu  Plot  settings  >Add  traces.  Sélectionnez  vos  signaux  et  ajoutez  les  opérateurs 
mathématiques. La fonction est composée dans le bas de la boite de dialogue. Validez.
Exs: d(V(out)) trace la dérivée de la tension du nœud Out.  V(Ur1)*I(R1) trace la puissance 
dans R1. Une liste des fonctions les plus courantes est disponible en Annexe. (Page-28)

Changer les échelles
Changer l'échelle d'un axe est simple. Déplacez vous sur un axe et une mini règle apparaît.
Cliquez gauche. Une fenêtre de configuration s'ouvre. Rentrez vos limites et validez. 
(Fonction utile pour comparer deux courbes)
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Créer un nouveaux repères
Clic droit sur la fenêtre de graphiques et dans le menu choisissez « Add plot planes ».

Désynchronisez les axes 
horizontaux.
Par  défaut,  tout  nouveau 
graphique adopte comme 
unité  en  abscisse  l'unité 
du premier graphique.
On  peut  désynchroniser 
les axes en cliquant droit 
sur  la  fenêtre  de 
graphiques  et  en 
décochant     « Desyn.  
Horiz.  Axes ».  Il  est  à 
présent possible de tracer 
n'importe  quel  signal, 

tension ou courant, en fonction d'un autre. 

Changer l'axe des X. 
En  simulation  temporelle  vous  pouvez  tracez 
n'importe quelle tension ou courant en fonction d'un 
autre.  Procédez  comme  pour  changer  l'échelle  des 
axes.(voir  23 )  mais au lieu de changer les valeurs 
modifiez le nom de l'axe.  Vous obtenez sur le bord 
gauche du bas de la fenêtre  le nom d'un noeud en 
déplaçant la souris sur un point du circuit. 

Par  exemple  I(R1)  (voir  -  Illustration  15:
Changement axe des X)

Sauvegarder vos courbes

Activez la fenêtre des traces. Menu Plot settings > Save plot settings

A écrire ...
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Illustration 16: Sonde de tension

Illustration 15: Changement axe des X
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Exemples

Création du circuit  LM311.

Nous allons dans cet exemple utiliser un Comparateur  LM311. Qui ne se trouve pas dans les 
bibliothèques Ltspice.

Le symbole
Tout d'abord nous allons construire une 
représentation  graphique  du  LM311  et 
l'enregistrer  dans  une  de  nos 
bibliothèques. Notez lors de la création, 
les  numéros  des   nœuds.  Ils  vous 
serviront  pour  la  correspondance  au 
modèle. 

Les propriétés
Chaque élément dans Spice à une lettre 
de  référence  V  (source  de  tension)  I: 
courant R: résistance … Vous trouverez 
la liste des éléments dans l'aide.

 X  désigne  un  composant  faisant 
référence à un modèle spice  Subcircuit 
Si vous renseignez l'attribut  Modelfile 
dans l'éditeur de symbole avec le nom 
de votre fichier de modèles, alors vous 
aurez la liste des modèles disponibles 
dans  le  fichier  qui  apparaîtrons  sous 
forme  de  liste  lors  de  l'utilisation  du 
symbole ( voir la diode en exemple).

Remarque  importante: Si  vous  ne 
renseignez  pas  le  champ  préfix le 
modèle  utilisé  sera  par  défaut  un 
schéma portant le même nom que votre symbole

Donnez la propriété X au préfixe et LM311 au champ Value.  
Ajoutez la propriété <Instance Name>   Edit Attributes>attribut  window pour que votre 
symbole soit numéroté automatiquement . Puis enregistrez votre œuvre. 

Schématique
Ouvrez un nouveau schéma et  réalisez le montage suivant. Placez le LM311, un pont diviseur 
sur l'entrée +,  un générateur sur l'entrée moins  et  un autre pour l'alimentation du circuit. 
Configurez V2 en sinusoïdale freq:100 hz  8volts et V1 en tension fixe 15 Volts. Entrez la 
directive  Spice  .lib pour donner le chemin de la bibliothèque.
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Simulation
Lancez la simulation et visualisez vos  résultats. (Voir - .Mesures & curseurs Visualisation des
résultats.)

Retour P3 Page 26 / 30
Carlos.Valente@brive.unilim.fr GE&II 19100 BRIVE - France.

mailto:Carlos.Valente@brive.unilim.fr


LTspice Version document du 07/04/2009

© Geii. Brive 2006
Utilisation des directives .step

On  peut  utiliser  les  directives 
.step  pour  réaliser  toutes  sortes 
de  simulations  où  il  est 
nécessaire  de  faire  varier  un 
paramètre  entre  chaque 
simulation.  Ci-contre  on  réalise 
une simulation pour trois valeurs 
différentes de Res11.

Vous  pouvez  ensuite  choisir  de 
ne visualiser qu'une seule courbe 
avec  la  fonction  select  
steps.

Transformée de Fourier ( FFT)

Ltspice peut réaliser une transformée de Fourier et 
visualiser le spectre du signal sur un noeud.  Dans 
la fenêtre de visualisation des traces cliquez sur le 
bouton droit de la souris. Choisissez FFT.

Une nouvelle fenêtre apparaît vous demandant le 
signal à visualiser.
Dans  notre  exemple  nous  avons  configuré  la 
source pour délivrer un signal sinusoïdale  Utilisez 
les curseurs2 pour mesurer la raie et vérifier que la 
fréquence de la source est de  1kHz.

1 Résistance série de la self. (10-3 ohm par défaut)
2 (Voir Illustration 14: Utiliser les curseurs)
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Annexes

Liens Utiles

Nom du liens Mots clefs
Site de Linear Technologie   Ltspice,Models, ...
Notice en Anglais. http://ltspice.linear.com/software/scad3.pdf 

National semiconducteur LM311 spice

Groupe Ltspice Nécessite un enregistrement

Tableau 1: Liens utiles

Unités SI (Système International)

Attention M correspond à milli et non à Méga.

Suffixe Exposant
T         
 G         
Meg       
 K        
M  ou m    
u ou  µ   
 n       
 p  
f       

1e12   
1e9    
1e6   
1e3     
1e-3    
1e-6   
1e-9    
1e-12    
1e-15 

Listes des fonctions

Voici une liste restreinte des fonctions utilisables dans LTSPICE.
• - pour ajouter ou soustraire
• * pour multiplier deux valeurs 
• ** pour élever en exposant ( **2 = au carré)
•  Time, Pi, Frequency .. 

Nom Fonction                
 abs(x) |          Valeur absolue
Cos(x), sin(x), tan(x), Fonctions trigonométriques 
acos(x), asin(x), atan(x) ...........................
acosh(x),  asinh(x), atanh(x)     ...........................
exp(x), log(x),  ln(x), log10(x) fonctions logarithmiques 
sqrt(x) Carré
D( signal) Dérivée de signal

Tableau 2: Fonctions mathématiques La suite dans l'aide Ltspice.
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